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Dalam mengatur persediaan bahan baku kayu pada pihak CV. Jati Sari masih
dilakukan berdasarkan pengalaman pribadi pemilik badan usaha. Karena
didasarkan pada pengalaman pribadi tanpa melakukan analisis atau peramalan
yang mendalam akan memunculkan resiko kelebihan atau kekurangan stok
sehingga membuat pengelolaan stok menjadi tidak efisien. Metode
pengembangan perangkat lunak yang digunakan yaitu metode Waterfall
Double Exponential Smoothing diimplementasikan pada penelitian ini sebagai
metode perhitungan prediksi peramalan. Penelitian ini menghasilkan sistem
prediksi yang dapat menghasilkan output berupa jumlah prediksi kayu yang
diperlukan sebagai persediaan atau stok dalam gudang dalam satuan meter
kubik. Untuk perhitungan manual metode DES memiliki hasil perhitungan
prediksi periode ke 21 adalah sebesar 4,8 m>. Berdasarkan pengujian sistem
menggunakan black box dan white box testing yang sudah dilakukan, dapat
disimpulkan bahwa sistem prediksi pengadaan stok bahan baku kayu
menggunakan metode Double Exponential Smoothing berbasis website berhasil
dengan baik dalam menyelesaikan permasalahan dalam memprediksi jumlah
stok bahan baku kayu periode mendatang pada CV. Jati Sari.

Abstract

In managing the supply of wood raw materials at CV. Jati Sari is still carried out
based on the personal experience of business entity owners. Because it is based
on personal experience without carrying out in-depth analysis or forecasting, it
will create a risk of excess or shortage of stock, making stock management
inefficient. The software development method used is the Waterfall method.
Double Exponential Smoothing is implemented in this research as a forecasting
prediction calculation method. This research produces a prediction system that
can produce output in the form of a predicted amount of wood needed as
inventory or stock in the warehouse in cubic meters. For manual calculations, the
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DES method has a prediction calculation result for the 21st period of 4.8 m3. Based
on the system testing using black box and white box testing that has been carried
out, it can be concluded that the prediction system for procurement of wood raw
material stock using the website-based Double Exponential Smoothing method
has succeeded well in solving the problem of predicting the amount of wood raw
material stock for the next period at CV. Jati Sari.

1. LATAR BELAKANG

CV. Jati Sari merupakan sebuah badan usaha yang bergerak pada bidang manufaktur atau pembuatan
mebel sesuai dengan permintaan konsumen. Melihat kondisi yang terjadi pada badan usaha milik CV. Jati Sari
sampai saat ini, masih terdapat masalah dalam penyetokan bahan baku kayu. Berdasarkan hasil wawancara
dengan pemilik badan usaha CV. Jati Sari, sistem dalam mengatur persediaan bahan baku kayu pada pihak CV.
Jati Sari masih dilakukan berdasarkan pengalaman pribadi pemilik badan usaha. Karena didasarkan pada
pengalaman pribadi tanpa melakukan analisis atau peramalan yang mendalam akan memunculkan resiko
kelebihan atau kekurangan stok sehingga membuat pengelolaan stok menjadi tidak efisien. Pembelian persediaan
lebih sering dilakukan ketika mendapat penawaran dari orang-orang yang datang langsung ke lokasi badan usaha.
Karena penawaran pohon dari kepemilikan personal, biasanya kayu yang ditawarkan tidak dalam jumlah yang
besar. Sedangkan untuk mendapatkan kayu, pemilik badan usaha hanya mengandalkan informasi dari orang yang
dikenal saja. Sedangkan apabila pihak badan usaha berada di kondisi yang membutuhkan banyak stok, pihak CV
akan kesulitan mencari stok kayu. Untuk menanggulangi itu, pihak badan usaha perlu mempersiapkan jumlah stok
sejak jauh hari. Apabila penyetokan barang tidak sesuai atau mengalami kehabisan bahan baku maka hal ini dapat
memunculkan kemungkinan pembeli barang kecewa bahkan beralih ke industri mebel lainnya (Irianti, 2022). Untuk
itu, pengendalian tingkat stok merupakan prasyarat penting untuk meminimalkan risiko kerugian yang harus
ditanggung perusahaan dan untuk memenuhi kebutuhan konsumen (Melinda & Santi, 2021).

Selanjutnya, dampak yang disebabkan karena masalah penumpukan adalah dikarenakan produk identik
berukuran besar, tentunya membutuhkan lokasi penyimpanan yang cukup luas untuk menampung stok kayu
sedangkan kondisi gudang yang kurang memadai dan terbatas, apabila persediaan bahan baku kayu dalam
gudang mengalami overstock akan membuat kerugian bagi pihak CV. Jati Sari. Hal ini dikarenakan akan membuat
bahan baku kayu susah untuk diolah sehingga menurunkan kualitas kayu jika digunakan sebagai bahan baku
mebel. Selain itu, kayu dapat mengalami perubahan warna dan penampilan hingga mengalami pengerasan, kering
hingga pembusukan (Denny Irawan, 2022). Selain itu, penumpukan persediaan yang terlalu banyak akan
memerlukan modal kerja yang besar, hal ini akan menyebabkan alokasi modal untuk kegiatan lain menjadi
terhambat (Ali & Bintang, 2022).

Oleh karena itu, diperlukan sebuah sistem prediksi yang mampu meramalkan kapan harus dilakukan
pengadaan stok bahan baku kayu, yang mana diharapkan dalam mengatur jumlah stok kayu yang perlu disediakan
akan lebih terukur. Apabila metode prediksi ini diterapkan dalam bagian proses perencanaan produksi, maka
pihak perusahaan akan lebih terbantu dalam penjadwalan produksi karena metode ini dapat memberikan output
yang baik sehingga diharapkan resiko kesalahan yang disebabkan oleh kesalahan perencanaan dapat ditekan
seminimal mungkin (Frans, Orisa, & Wibowo, 2020).

2. METODE

Metode Waterfall merupakan metode pengembangan perangkat lunak yang menggambarkan
pendekatan yang sistematis dan juga berurutan pada pengembangan perangkat lunak (Heriyantoro, Dzulhag, &
Silitonga, 2020). Model waterfall sendiri terdiri dari beberapa tahapan yang harus diselesaikan secara berurutan,
mirip dengan air mengalir ke bawah (waterfall). Setiap tahap harus diselesaikan sebelum melanjutkan ke tahap
berikutnya. Metode waterfall mencakup beberapa langkah yaitu requirement analysis (analisis kebutuhan), system
design (perancangan sistem), implementation (penerapan kode program), testing (pengujian) dan maintenance
(pemeliharaan). Langkah detailnya dapat dilihat pada Gambar 1 berikut ini
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Gambar 1 Tahapan Metode Waterfall

Pada penelitian ini menggunakan penelitian secara R&D (Research and Development) karena pada
penelitian ini peneliti akan melakukan pembuatan perangkat lunak yang dapat digunakan untuk prediksi stok
kayu dengan menggunakan metode Double Exponential Smoothing.

Pemulusan eksponensial (exponential smoothing) adalah suatu metode peramalan satu linier yang
dikemukakan oleh Brown, peramalan ini melakukan pemulusan tunggal kemudian dilakukan lagi dengan
pemulusan ganda. Metode ini biasa digunakan untuk pola data yang berunsur trend. Dasar pemikiran dari metode
exponential smoothing tunggal maupun ganda adalah bahwa nilai pemulusan akan terdapat pada waktu sebelum
data sebenarnya apabila pada data tersebut terdapat komponen trend. Oleh karena itu, untuk nilai-nilai
pemulusan tunggal perlu ditambahkan nilai pemulusan ganda untuk menyesuaikan trend (Elison, Asrianto, &
Aryanto, 2020). Adapun rumus dari perhitungan metode Double Exponential Smoothing adalah sebagai berikut
(PASARIBU, 2021):

1. Pemulusan Eksponensial Tunggal:

Si=aX, + 1—-a)S';_4 (1)

dimana:

S’; = nilai untuk mencari Pemulusan Eksponensial Tunggal (Single Eksponensial Smoothing Value)

« = nilai alpha, parameter pemulusan eksponensial

X, = nilai aktual periode ke-t

2. Pemulusan Eksponensial Ganda:

S =aS's + 1—-a)S":_; (2)

dimana:

S'; = nilai untuk mencari Pemulusan Eksponensial Tunggal (Single Eksponensial Smoothing Value)

S = nilai untuk mencari Pemulusan Eksponensial Ganda (Double Exponential Smoothing Value)

a = nilai alpha, parameter pemulusan eksponensial

X; = nilai aktual periode ke-t

3. Pemulusan Trend:

a, =25',—S", 3)

dimana:

a, = konstanta pemulusan

S’; = nilai untuk mencari Pemulusan Eksponensial Tunggal (Single Eksponensial Smoothing Value)

S, = nilai untuk mencari Pemulusan Eksponensial Ganda (Double Exponential Smoothing Value)

4. Pemulusan Trend:

b, = ﬁ S't=5") 4)

dimana:

a; = konstanta pemulusan

S'; = nilai untuk mencari Pemulusan Eksponensial Tunggal (Single Eksponensial Smoothing Value)

S": = nilai untuk mencari Pemulusan Eksponensial Ganda (Double Exponential Smoothing Value)

a = nilai alpha, parameter pemulusan eksponensial

5. Ramalan:

Fiym = ar +bm ©)

dimana:

F;.m = hasil peramalan untuk m periode kedepan
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m = periode masa mendatang

a; ,b;= konstanta pemulusan

Flowchart atau biasa disebut dengan diagram alir merupakan suatu jenis diagram yang merepresentasikan
algoritma atau langkah-langkah instruksi yang berurutan dalam sistem. Diagram ini digunakan untuk menjelaskan
gambaran logis sebuah sistem yang akan dibangun kepada programmer. Dengan demikian, flowchart dapat
membantu untuk memberikan solusi terhadap masalah yang bisa saja terjadi dalam membangun sistem. Dengan
adanya flowchart, setiap urutan proses dapat digambarkan menjadsi lebih jelas (Rosaly). Dengan kata lain,
kegunaan dari flowchart sendiri adalah sebagai penolong analisis dan pemrograman dalam sebuah proyek sistem
informasi untuk memecahkan masalah yang dihadapi oleh user ke dalam segmen-segmen yang lebih detail
(Gutama, 2019).

3. HASIL DAN PEMBAHASAN

Pada sub bab ini akan dijelaskan mengenai tampilan dan perancangan aplikasi prediksi stok bahan baku
kayu menggunakan metode Double Exponential Smoothing. Tujuan perancangan sistem ini untuk membantu
admin dalam menentukan jumlah stok kayu periode mendatang berdasarkan data histori pemakaian stok.

Selamat Datang

Gambar 1 Implementasi Ul Halaman Login
Pada Gambar 2 halaman login, user dapat mengisi username dan password. Jika admin memasukkan
username dan password dengan benar, maka admin akan masuk ke halaman dashboard.

< Menu

Menu Jenis Kayu

List Jenis Kayu
Tambah Histori Pemakaian

Jenis Kayu Total Stok Total Pemakaian

Jat 600 20

Historis Prediksi

Show| 10w |entries Search:

Jenis Kayu *  Alpha Periode Prediksi Tanggal Perhitungan Aksi

lati 0.42 1 2024-07-0618:24:46 ﬂn
lati 05 1 2024-07-0618:2813 nn

Gambar 2 Implementasi Ul Halaman Dashboard

Pada tampilan menu dashboard akan ditampilkan menu list jenis kayu seperti pada Gambar 3 yang berisi
jenis kayu dan total jumlah pemakaian. Selain itu ditampilkan data historis prediksi yang berisi jenis kayu,
parameter alpha yang digunakan, jumlah periode prediksi dan tanggal perhitungan. Pada data historis prediksi ini
juga dapat dilakukan aksi untuk melihat detail hasil prediksi dan hapus list data historis prediksi.
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Import Data Kayu

Pilinfile Excel (.xlsx)

PilihnFile = Tidak ada file yang dipilih

oo

Gambar 3 Implementasi Ul Form Tambah Data Histori
Kemudian pada Gambar 4 terdapat form yang digunakan ketika admin akan menambah data histori
pemakaian. Pada form tersebut admin akan diminta untuk import data sesuai dengan template yang telah
disediakan oleh sistem.

< Menu
History
History
Semua lenis Kayu v hh/bb/tttt o
Jenis Kayu Jumilah Persediaan Pemakaian Tanggal Actions
Jati 50 20 2024-01-01 |
Iati 30 2024-01-10 7 W
Jati 40 1o} 2024-01-23 7|
Jati 20 5 2024-01-30 & W

Gambar 4 Implementasi Ul Halaman Histori
Pada Gambar 5 ditampilkan halaman history, terdapat list seluruh data kayu yang telah di import oleh
admin di halaman dashboard. Data yang ditampilkan meliputi data jenis kayu, jumlah persediaan, jumlah
pemakaian, tanggal dilakukan prediksi dan actions yang berisi edit data dan hapus data. Selain itu, admin juga
dapat menggunakan filter jenis kayu dan tanggal.

Form Prediksi Double Exponential Smoothing
¥ Jenis Kayu:

Jat w
® Pericde Prediksi: @

]

»Prediksi

Gambar 5 Implementasi Ul Form Prediksi DES
Berikutnya pada halaman prediksi seperti pada Gambar 6, admin akan diminta untuk input data jenis kayu
yang akan diprediksi dan jumlah periode yang akan diprediksi. Setelah menekan button hitung prediksi, sistem
akan menampilkan hasil prediksi seperti pada Gambar 7.

Page 2067 of 2071



Jutin : Jurnal Teknik Industri Terintegrasi, 2024, 7(4), Pages 2062-2071

Sistem DES < Menu

Hasil Prediksi Double Exponential Smoothing

Parameter Prediksi

Prediksi Stok Kayu Jati Selanjutnya

Rekomendasi Tindakan:
"
Metrik Evaluasi
MAPE MAD MSE
Prediksi Periode Selanjutnya
Hasl Prediksi
1 Periode 2
: Tanggal
Prediks| Prediksi:
Hasil Perhitungan
Tanggal Aktual Level (St) Trend (Bt) Prediksi Error Absolute Error Squared Error Percentage Error

0. 0.0C

8.84 016 016 0.03 8

Grafik Prediksi

Kembali ke Form

Gambar 6 Implementasi Ul Hasil Prediksi
Pada Gambar 7 ditampilkan halaman hasil prediksi. Pada halaman ini sistem akan menampilkan hasil
perhitungan metode Double Exponential Smoothing yang berisi jumlah prediksi stok kayu periode berikutnya,
metrik evaluasi, hasil perhitungan dan terakhir terdapat grafik prediksi.

Pengujian Sistem
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Pengujian dengan black box digunakan untuk menguiji sistem prediksi tanpa memahami secara spesifik
struktur kode komputer. Tujuan pengujian ini adalah untuk menguji input dan output dari sistem yang
dikembangkan. Selain itu, pengjian ini dilakukan untuk memeriksa masalah atau bug pada sistem serta untuk
melihat apakah sistem berfungsi sebagaimana mestinya. Pada Tabel 1 akan ditunjukkan hasil pengujian black box.

Tabel 1 Hasil Black Box Testing

No Input Yang Diharapkan Output Kesesuaian

1 Username  dan | Pengguna Pengguna berhasil Sesuai
password valid diarahkan ke | diarahkan ke Halaman

Halaman Dashboard
Dashboard

2 Username dan | Pesan  kesalahan | Berhasil memunculkan Sesuai
password  tidak | login ditampilkan pesan kesalahan login
valid

3 Klik tombol | Template terunduh | Template berhasil diunduh Sesuai
download
template

4 Import file | Data histori di | Data histori berhasil di Sesuai
template data | import dan | import dan disimpan
histori valid disimpan

5 Import file | Pesan  kesalahan | Menampilkan pesan Sesuai
template data | import data | kesalahan import data
histori tidak valid | ditampilkan

6 Edit data histori | Menampilkan data | Menampilkan data histori Sesuai
pemakaian kayu histori yang valid yang sudah diperbarui

7 Input form | Menampilkan hasil | Berhasil menampilkan Sesuai
prediksi prediksi hasil prediksi

8 Hapus data histori | Data histori | Berhasil menghapus data Sesuai
prediksi prediksi dihapus histori prediksi

White Box Testing atau pengujia kotak putih adalah metode pengujian perangkat lunak yang dilakukan
dengan memeriksa dan memahami struktur internal dari perangkat lunak yang diuji. Tujuannya adalah untuk
memastikan bahwa semua bagian dari kode tersebut berfungsi dengan baik sesuai dengan spesifikasi yang telah
ditetapkan. Pada penelitian ini, white box testing akan menggunakan pendekatan basis path testing. Tabel 2 berikut

ini merupakan tabel hasil pengujian white box dengan pendekatan basis path testing.
Tabel 2 Hasil White Box Testing

No Skema Path Deskripsi Langkah Pengujian Hasil

1 P1:  Mulai -> | Validasi kredensial | 1.  Masukkan kredensial | Sukses:
Login sukses -> | dengan kredensial yang | yang valid Pengguna
Dashboard benar 2. Verifikasi  pengguna | diarahkan ke

diarahkan ke dashboard dashboard

2 P2: Mulai -> | Validasi kredensial | 1. Masukkan kredensial | Sukses: Pesan
Login gagal -> | dengan kredensial yang | yang tidak valid kesalahan
Pesan Error salah 2. Muncul verifikasi pesan | ditampilkan

kesalahan

3 P3: Dashboard - | Proses pengunduhan | 1. Klik pada tombol | Sukses: File
> Download | template "Download Template" template
Template -> 2. Verifikasi file berhasil | berhasil
Sukses diunduh diunduh

4 P4: Dashboard - | Kegagalan pengunduhan | 1.Simulasikan  kegagalan | Sukses:
> Download | template (misal, jaringan terputus) 2. | Kesalahan
Template -> Verifikasi penanganan | ditangani
Gagal kesalahan dengan benar

5 P5: Dashboard - | Proses impor data histori | 1. Unggah file data histori | Sukses: Data
> Import Data valid disimpan
Histori -> 2. Verifikasi data disimpan | dengan benar
Sukses dalam sistem

6 P6: Dashboard - | Kegagalan impor data | 1. Unggah file data histori | Sukses: Pesan
> Import Data | histori tidak valid kesalahan
Histori -> Gagal ditampilkan
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No | Skema Path Deskripsi Langkah Pengujian Hasil
2. Verifikasi pesan
kesalahan muncul
7 P7: Dashboard - | Pembaharuan data histori | 1. Edit data histori dengan | Sukses: Data
> Edit Data data valid berhasil
Histori -> 2. \Verifikasi  perubahan | diperbarui
Sukses disimpan
8 P8: Dashboard - | Input data prediksi valid 1. Masukkan data valid | Sukses: Hasil
> Halaman pada form prediksi
Prediksi -> 2. Verifikasi hasil prediksi | dihasilkan
Input Form -> muncul
Sukses
9 P9: Dashboard - | Penghapusan data histori | 1. Hapus data histori | Sukses: Data
> Edit Histori | prediksi prediksi histori prediksi
Prediksi -> 2. Verifikasi  perubahan | dihapus
Sukses diterapkan
10 | P10: Dashboard | Terminasi sesi pengguna | 1. Klik "Logout" Sukses: Sesi
-> lLogout -> 2. Verifikasi  pengguna | pengguna
Sukses diarahkan keluar dan sesi | berakhir
berakhir

Pengujian black box dan white box merupakan dua metode utama yang digunakan untuk memastikan
keandalan dan kualitas sistem prediksi. Pengujian black box dilakukan tanpa memahami struktur internal dari
kode, dengan tujuan utama untuk memverifikasi bahwa input menghasilkan output yang diharapkan dan untuk
mendeteksi adanya bug atau masalah berdasarkan respon sistem terhadap berbagai skenario penggunaan. Dalam
pengujian ini, berbagai aspek seperti login, pengunduhan template, impor data, dan manipulasi data diuji, dan
hasilnya menunjukkan bahwa sistem berfungsi sesuai dengan harapan. Di sisi lain, pengujian white box melibatkan
pemeriksaan mendalam terhadap struktur internal perangkat lunak untuk memastikan semua bagian kode
berfungsi sesuai dengan spesifikasi yang ditetapkan. Metode basis path testing digunakan untuk menguiji setiap
jalur logika dalam program, memastikan tidak ada cacat logika yang dapat menyebabkan kegagalan sistem. Hasil
pengujian white box juga menunjukkan bahwa setiap skenario pengujian internal telah berhasil, mulai dari validasi
kredensial hingga terminasi sesi pengguna. Dengan menggabungkan kedua metode ini, pengujian komprehensif
memastikan bahwa sistem prediksi tidak hanya dapat diandalkan dari perspektif pengguna akhir, tetapi juga
memiliki kualitas kode yang tinggi dan bebas dari masalah internal, sehingga siap digunakan dalam lingkungan
produksi dengan risiko minimal.

4. KESIMPULAN

Berdasarkan pengujian sistem yang sudah dilakukan, dapat disimpulkan bahwa sistem prediksi
pengadaan stok bahan baku kayu menggunakan metode Double Exponential Smoothing berbasis website berhasil
dengan baik dalam menyelesaikan permasalahan dalam memprediksi jumlah stok bahan baku kayu periode
mendatang pada CV. Jati Sari. Sistem prediksi pengadaan stok barang ini mampu meminimalisir kesalahan
kelebihan dan kekurangan barang yang dilakukan oleh hasil perhitungan prediksi pengadaan stok bahan baku.
Ketika proses prediksi mendekati nilai akurat, maka stok bahan baku yang disediakan oleh CV. Jati Sari akan lebih
tepat sesuai dengan kebutuhan. Dengan demikian maka prediksi jumlah stok barang berdasarkan jenis kayu akan
sangat membantu untuk menentukan jenis kayu apa saja yang harus ada di setiap pengadaan barang.

5. SARAN

Sistem yang dibuat tentunya masih terdapat beberapa kekurangan yang dapat dijadikan perbaikan
ataupun pengembangan bagi penelitian selanjutnya. Saran pada penelitian yang akan datang dapat berupa sistem
prediksi dapat dikembangkan menggunakan algoritma yang lain, sehingga dapat dijadikan sebagai perbandingan
untuk mendapat hasil yang akurat.
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